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Abstract

HE5View is a file viewing tool developed for the ECS project for the examination and
verification of HDF-EOS Version 5.x data files. This tool enables the user of EOS data
products to view the contents of HDF-EOS files and individual objects by being able to read and
display all metadata fields and data objects appropriately. Supported record types for viewing
and display capability include Swath, Grid, and Point objects in table, image and text format.
Attributes and annotations can also be viewed. HES5View users will not see the underlying
HDFS5 structures but will be prompted for which parts of the HDF-EOS structure they wish to
view.

The HESView application is able to convert HDF-EOS data files to a particular type, ASCII and
binary, for storage on a user’s disk space so that the user can then make further use of analysis
and visualization tools already available in commercial public domain systems. HE5View is
then able to open and provide the means for ingesting HDF-EOS files into other software
systems.

Keywords: HE5View, HDFEOS, HDF, images, point, swath, grid
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1. Introduction

1.1 Identification

The HE5View User’s Guide for the ECS Project was prepared under the Earth Observing
System Data and Information System (EOSDIS) Core System (ECS), Contract (NAS5-60000).

1.2 Scope

This document is intended for use by anyone who wished to verify or inspect EOS data products
written as HDF-EOS Version 5.x. Users of this document will include EOS instrument team
science software developers and data product designers, DAAC personnel, and end users of EOS
data products, i.e. scientists and researchers.

1.3 Purpose and Objectives

This document will serve as a user’s guide for the HESView data verification tool, developed for
ECS. The reader should have an understanding of the user interface and the functionality
provided with the tool. A cursory understanding of HDF5 and HDF-EOS data structures is
recommended, but not required.

Information on HDF-EOS Version 5.x can be found in The HDF-EOS Users Guide for the ECS
Project. Information on HDFS5 can be found in The NCSA HDFS5 User’s Guide.

1.4 Status and Schedule

1.5 Document Organization
This document is organized as follows:
Section 1 Introduction - Presents Scope and Purpose of this document
Section 2 Related Documentation
Section 3 Overview of HE5View - Background and design features of the tool

Section 4 Installation and Maintenance - Information on obtaining the tool, supported
platforms, user help

Section 5 HESView User Interface



2. Related Documentation

2.1 Parent Documents
The following document is the parent from which this document’s scope and content derive:

423-41-03 Goddard Space Flight Center, EOSDIS Core System Contract Data Requirements
Document, Data Item Description No. 311

423-41-03 Goddard Space Flight Center, EOSDIS Core System Contract Data Requirements
Document, Data Item Description No. 609

2.2 Related Documents

The following documents are directly applicable to this requirement’s specification:
333-CD-003-001 SDP Toolkit Users Guide for the ECS Project
170-TP-001-001 HDF-EOS Users Guide for the ECS Project

none University of Illinois, An Introduction to HDF5

none University of Illinois, NCSA HDFS5 User’s Guide

none University of Illinois, NCSA HDF5 Reference Manual

none University of Illinois, NCSA HDF5 Application Developer’s Guide



3. Overview of HDF and HDF-EOS

3.1 Introduction

Prior to discussing HESView, it is helpful to provide an overview of the data formats which the
tool is designed: namely HDFS5.

The Hierarchical Data Format (HDF) has been selected by the Earth Observing System (EOS)
Data and Information System, Core System (ECS) Project as the format for EOS standard
product distribution. HDF is a general scientific data format, which supports raster, text, array
and table type structures. The files are self-describing and portable to most Unix systems. HDF
data structures are implemented with a software interface supplied by the National Center for
Supercomputing Applications (NCSA). See NCSA HDF User’s Guide and references. HDF has
been extended by the ECS Project to focus conventions for writing EOS data products. These
extensions, called HDF-EOS, are described below.

HES5View has been designed to supply the user with the capability of opening and inspecting the
contents of an HDF-EOS data file using HDF5. The tool will provide producers and users of
EOS data the ability to navigate through HDF-EOS files, display metadata, file directory
information, and data in table and/or image form.

3.2 HDF and HDF-EOS File Formats

3.2.1 Overview

Most of the NCSA defined datatypes map well to EOS datatypes. Examples include raster
images, multi-dimensional arrays, and text blocks. There are other EOS datatypes, however, that
do not map directly to NCSA datatypes, particularly in the case of geolocated datatypes.
Examples include projected grids, satellite swaths, and field campaign or point data.

An HDFS5 file consists of a directory, and records pointed to by that directory. Each directory
entry conists of fields for the record type (TAG), a unique ID number (REF), and a location and
size of the record pointed to. All locations in the HDF file are in byte locations from the
beginning of the file. All record sizes are also specified in bytes.

Supported record types include images, multidimensional arrays, text, tables (known in HDF as
Vdatas), and so on. One record type, known as Vgroup, lets the user group a series of records
into a larger structure, similar to disk directories.

To bridge the gap between the needs of EOS data products and the capabilities of HDF, the ECS
Project has developed extensions of HDF, which standardize the conventions for writing HDF
files, and are called HDF-EOS. Theses extensions facillitate the creation of Grid, Point, and
Swath data structures. The software interface for the HDF-EOS implementation is very similar



to the HDF interface. See HDF-EOS Users Guide for the ECS Project [170-TP-001-001] and
references.

The Point interface is designed to support data that has associated geolocations information, but
is not organized in any well defined spatial or temporal way. The Swath interface is tailored to
support time-ordered data such as satellite swaths (which consist of a time-ordered series of
scanlines), or profilers (which consist of a time-ordered series of profiles). The Grid interface is
designed to support data that has been stored in a rectilinear array based on a well defined and
explicitly supported projection.

3.2.2 Structure of an HDF-EOS File

An HDF-EOS file is any valid HDF5 file (i.e. any file created by the NCSA HDF library), that
contains a family of global attributes called “coremetada.X”, where “.X” is a sequence number
beginning at 0 and running as high as 9. Optional data objects which may appear in an HDF-
EOS file include, another family of global attributes called “archivemetadata.X” and any number
of Point, Swath, and/or Grid data structures. The existence of Point, Swath, or Grid structures in
an HDF-EOS file implies the existene of another family of global attributes called
“StructMetadata.X”. These terms are defined below.

Core Metadata

Core Metadata represent information which will be used to populate searchable tables within the
structure. These metadata, which are defined in DID 311, are contained in the “coremetadata. X
(X=0,...,n) family of global attributes within an HDF-EOS file. The syntax of these metadata is
compliant with the Object Description Language (ODL). Tools for formatting, accessing and
writing core metadata are provided in the ECS Science Data Processing (SDP) Toolkit.

Archive Metadata

Archive metadata represent information that, by definition, will not be searchable. It contains
whatever information the file creator considers userful to be in the file, but which will not be
directly accessible for the system. These metadata are also accessed via SDP Toolkit calls and
are written in ODL syntax into the “archivemetadata.X”, (X=0,...,n) family of global attributes.

Structural Metadata

Structural metadata describe the contents and structure of an HDF-EOS file. These metadata are
present in the file only if the HDF-EOS library has been invoked to create a Grid, Point, or
Swath structure. These metadata are stored in the “StructMetadata.X” family of global attributes
and are created and maintained by the HDF-EOS library. These metadata are not intended to be
directly accessed by data producers or users. Therefore, all access to these metadata should be
via appropriate function calls in the HDF-EOS library.

Point Structure

Point structures are implemented in HDF-EOS files as a hierarchy of Vgroups containing several
Vdatas, i.e. tables. All Vgroups and Vdatas that are part of any Point structure carry the class
“POINT”. Each level of data within a Point structure is implemented as a single Vdata, with
each data field being named field in the Vdata.



The following limitations apply to Point structures and should be kept in mind by EOSView
users:

e The reserved field names for special purpose geolocation fields are “Longitude”, “Latitude”,
“Colatitude”, and “Time” (case sensitive). These fields are subject to the following

requirements:
Field Name Data Type Format
Longitude float32 or float64 Decimal degrees on the range [-180.0, 180.0]
Latitude float32 or float64 Decimal degrees on the range [-90.0, 90.0]
Colatitude float32 or float64 Decimal degrees on the range [0.0, 180.0]
Time float64 TAI93 (seconds until(-)/since(+) midnight 1/1/93)

¢ Fields may only be one-dimensional.
e Up to 8 levels may exist in a Point structure.
Swath Structure

Swath structures are implemented as a hierarchy of Vgroups containing a number of Vdatas
and/or SDSs, i.e. tables and multi-dimensional arrays. All Vgroups and Vdatas that are part of
any Swath structure carry the class “SWATH”. Each one-dimensional field is implemented as a
named field within its own Vdata. One-dimensional fields that are the same length, are merged
into “communal” Vdatas, with each data field occupying one field in the Vdata.

Each multi-dimensional field is implemented as an SDS. Three dimensional fields which share
the same dimensionality, dimension sizes, and data type and which are specifically allowed by
the calling program are merged into communal SDSs with three dimensions. Two-dimensional
arrays are merged as if they were three-dimensional arrays with a first dimension of size 1. No
merging is performed on fields with more than three dimensions, on fields with an unlimited
dimension, or on compressed fields.

The following limitations apply to Swath structures:

e The reserved field names for special purpose geolocation fields are “Longitude”, “Latitude”,
“Colatitude”, and “Time” (case sensitive). These fields are subject to the following

requirements:
Field Name Data Type Format
Longitude float32 or float64 Decimal degrees on the range [-180.0, 180.0]
Latitude float32 or float64 Decimal degrees on the range [-90.0, 90.0]
Colatitude float32 or float64 Decimal degrees on the range [0.0, 180.0]
Time float64 TAI93 (seconds until(-)/since(+) midnight 1/1/93)

These fields may be one- or two-dimensional



e Non-reserved fields may have up to 8 dimensions.
e An “unlimited” dimension must be the first dimension (in C-order).

e For all multi-dimensional fields in scan- or profile-oriented Swaths, the dimension
representing the “along track™ dimension must precede the dimension representing scan or
profile dimension(s).

e Compression is selectable at the field level within a Swath. All HDF-supported compression
methods are available through the HDF-EOS library. Specifying compression on a field
prevents merging.

Note: HES5View users need not be concerned whether a file has been compressed internally or
not. The tool will uncompress the file automatically.

Grid Structure

Grid structures are implemented as a hierarchy of Vgroups containing several SDSs. All
Vgroups that are part of any Grid structure carry the class “GRID”. Each data field within a
Grid structure is implemented as a single SDS. Merging is done the same way for Grid data
fields as for multi-dimensional Swath data fields.

The following limitations apply to Grid structures:
¢ Fields may have from 2 to 8 dimensions.

e Compression is selectable at the field level within a Grid. All HDF-supported compression
methods are available through the HDF-EOS library. Specifying compression on a field
prevents merging.

Note: HES5View users need not be concerned whether a file has been compressed internally or
not. The tool will uncompress the file automatically.



4. Environment, Installation and Maintenance

4.1 Introduction

HE5View is designed to be a stand-alone tool for accessing HDF-EOS Version 5.x files. The
installation instructions are described below.

4.2 Download Instructions

Downloading HE5View can be accomplished by using an ftp session. The address is:
ftp edhs1.gsfc.nasa.gov

Name: anonymous

Password: <your e-mail address>

ftp>quote site group sdptk

ftp> quote site gpass ecs-tkit

ftp>cd hdfeos5/tools/HESView

A README file will also be provided in this directory.
ftp>get README

This file will answer many questions you have about running HESView.
Change to the he5view directory that matches your hardware.
sgi/

solaris2.5/

dec/

hp/

Once in the directory set type to i, download the files, and exit.
ftp>bin

ftp>mget *

ftp>bye

The following files will be downloaded:

HE5View (executable)

heSview.csc  (hypertext on-line help file)



he5Sview.uid (user interface description file)
eosview.dat (IDL commands file)

Start HESView by typing ‘HESview’ at the command prompt. If the environment variables
described in Section 4.3.4 are not set, the current working directory must contain the four
HE5View files.

4.3 Notes

4.3.1 Approved Platforms

HES5View was built and tested in a multi-platform environment. The list of approved platforms,
which includes information about operating system is given in Table 4-1. The platforms should
run Motif 1.2 window manager.

Table 4-1. Operating Systems

Platform (0153 Version
Sun Sparc Solaris 251
DEC OSF/1 4.0
HP HP-UX 10.20
SaGl IRIX 6.2

4.3.2 Interfaces and Data Types

HE5View exchanges data of various types through internal interfaces within ECS:
e IDL for graphics

e XVT for GUI builder

e links with the HDF5 compile time library

4.3.3 Tunable Parameters

The following attributes can be modified through the standard .Xdefaults file:
e focus policy (mouse pointer)

e icon geometry (size and location)

e fonts

e colors

4.3.4 Environment Variables

Table 4-2 lists the environment variables for HE5SView. These variables are optional.



Table 4-2. Environment Variables

Required By Environment Variable Description or Valid Ranges
HES5View UIDPATH location of the hebview.uid file that contains a
description of GUI objects
HE5View EOSVIEWHELPDIR location of heSview.csc (hypertext on-line help
file) and eosview.dat file (idl commands)
HES5View ECS_HOME directory for File Selection dialog to begin

4.3.5 Special Constraints
HES5View will read only HDF-EOS Version 5.x formatted files.

4.3.6 Command Line Interface

HES5View has no command line argurment interface.

4.4 User Feedback Mechanism

The mechanism for handling user feedback, documentation and software discrepancies, and bug

reports follows:

1) The following account at the ECS Landover facility has been set up for user response:

pgstlkit@eos.hitc.com

2) Users will e-mail problem reports and comments to the above account. A receipt will
be returned to the sender. Responses will be prioritized based on the severity of the
problem and the available resources. Simple bug fixes will be turned around sooner,
while requested functional enhancements will be placed in a recommended

requirements data base (RRDB) and handled more formally.

3) In order to help expedite responses, we request the following information be supplied

with problem reports:

Name:

Date:

EOS Affiliation (DAAC, Instrument, Earth Science Data and Information System (ESDIS), etc.):

Phone No:
Computing Platform:

Operating System (including version):

Problem Description:







5. HE5View User Interface

5.1 Introduction

HES5View is a custom HDF-EOS Version 5.x file verification tool. It displays the contents of
HDF-EOS Version 5.x files. Individual objects can be selected for display. Displays include
datasets in tables, pseudo-color images of datasets, attributes, and annotations.

HES5View has a unique interface for handling HDF-EOS data structures. The Swath/Grid/Point
interface uses only HDF-EOS Version 5.x library calls. The HE5View operator will not see the
underlying HDFS5 structures but will be prompted for which parts of the structure they wish to
view.

HES5View is used to perform the operator functions listed in Table 5-1.

Table 5-1. Common ECS Operator Functions Performed with HE5View

interface (HDF-
EOS)

window for swath,
point and grid files

at a high level (i.e., data
types cannot be broken
down)

(10f 2)
Operating Command/Script Description When and Why to Use
Function or GUI
Swath/Point/Grid File Contents Display View HDF-EQOS objects To view segments of

data in terms of swath, a
point on the earth, and
grid (e.g., lat/long) data

Display of Field
data in table

data table

Displays a one or two
dimensional list of data in
a scrollable list

To view/compare
associated numbers




Table 5-1. Common ECS Operator Functions Performed with EOSView

(2 of 2)
Operating Command/Script Description When and Why to Use
Function or GUI
Pseudo-color Image Display ¢ Converts data into a To view the pseudo-
display of field Window visual image color image of a field
data o multiple zoom features | data table
in image display
available
¢ pan feature available
multiple palettes
available
Display text Text (Attributes) Describes the types of To look at factors when
objects Window data strings for an doing computations
individual object or for an | (e.g., longitude/latitude)
entire file
Hypertext help On-line Help On-line help is available to help in the navigation
from all menu bars and use of HESView
Plot Field Data HES5View Surface or contour plot of | To view plots of field
surface/contour plot field data data tables
window

5.2 Quick Start Using HE5View and GUI Overview

This section presents an orientation of HESView.

5.2.1 Invoke HE5View

HES5View can be started from the UNIX command line by typing the command:

HESView

5.2.2 HE5View Main Screen

The HESView Main Window (shown in Figure 5-1) displays the current version of HE5View

and date.




Figure 5-1. HE5View Main Screen

From the File pulldown menu, the operator can select Open or Exit.
® Open -- This will cause a file selection dialog to appear (shown in Figure 5-2)

e Exit — Exits HE5View

From the Window pulldown menu, the operator can select an HE5View window and have the
focus change to that window as long as it is currently open. This feature is described in Section
5.2.35 “Window Pulldown Menu.”

From the Help pulldown menu, the operator can select help on context, on help, on window,
keys, contents, index and version. This feature is described in Section 5.2.37 “Help Pulldown
Menu.”



5.2.3 HE5View File Selection Dialog

Selecting Open from the HE5View File pulldown menu will bring up the File Selection Dialog
shown in Figure 5-2. This is a standard file selection dialog box that lets the operator search
through directories and select an HDF-EOS Version 5.x file.

Figure 5-2. File Selection Dialog

Table 5-2 describes the File Selection fields.

Table 5-2. HES5View File Selection Field Description

Field Name Data Type Size Entry Description
Filter system generated |unlimited |required |displays file selection parameters to
(editable) filter the directories
Directories selection unlimited |required |displays a list of directories
Files selection unlimited |required |displays a list of files to select from




Select Input File system generated |unlimited [required |displays the filename selection

(editable)

In addition, the following pushbuttons are provided:

OK — opens the specified file

Filter — filters through the directories in layers until the desired directory/file is
displayed

Cancel — closes the file selection dialog

5.2.4 File Contents Display Pop-up

Once the HDF-EOS Version 5.x file has been selected, the File Contents Pop-up (see Figure 5-3)
for that file will appear. This is a scrollable window with the following menu items:

The File pulldown menu (described in Section 5.2.34) provides additional information
about a file and provides a way to close the file.

From the Window pulldown menu, the operator can select an HSEView window and
have the focus change to that window as long as it is currently open. This feature is
described in Section 5.2.35 “Window Pulldown Menu.”

From the Attributes pulldown menu (described in Section 5.2.36), the operator can view
the global attributes for the selected HDF-EOS Version 5.x file.

From the Help pulldown menu (described in Section 5.2.37), the operator can select help
on context, on help, on window, keys, contents, index and version.

To select an HDF-EOS Version 5.x object simply double-click on the object that is displayed in
the scrollable window. Objects can be Grid, Swath, or Point data. Each of these objects are
described in the following sections.

5.2.5 HES5View Grid Select GUI

In this example, the Grid.h5 was selected from the File Selection dialog, bringing up the
GridFile.hdf File Contents Display shown in Figure 5-3.



Figure 5-3. Grid File Contents Display Pop-up

Double-clicking on a selection (in this case, the object Group: UTMGrid {GRID} was selected)
brings up the Grid Select Pop-up shown in Figure 5-4.

Figure 5-4. Grid Select Pop-up



All of the following options are available for selection: Grid Information, Projection

Information, Dimensions, Data Fields, and Grid Attributes. Selecting OK will bring up
windows for all the items selected. Clicking on Cancel will return the operator to File Contents
Window. Assuming that all the items have been selected, the following windows will appear:

5.2.6 Grid Information Dialog

To view a summary of a selected Grid object, click on the Grid Information checkbox. The Grid
Information dialog pop-up (shown in Figure 5-5) displays information about the selected grid
such as X-Dimension value, Y-Dimension value, Upper Left Point values, and Lower Right
Point values.

Figure 5-5. Grid Information Dialog Pop-up

This window can be closed by pressing the OK button.



5.2.7 Projection Information

To view the Projection Information of the selected Grid object, click on the Projection
Information checkbox in the HESView - Grid Select window and press the OK button. This will
cause the HE5View - Grid Projection Information pop-up shown in Figure 5-6 to appear.



Figure 5-6. Projection Information Pop-up



The Projection Information pop-up displays information about the projection of the selected

grid in a dialog box. The first item displayed is the Projection itself. If the projection is
Universal Transverse Mercator, the next item is displayed in the Zone Code. For any other
projection the next items displayed are the thirteen (13) Projection Parameters. This window can
be closed by pressing the OK button.

5.2.8 Swath/Grid Dimensions

To view the dimensions of the selected Grid object, click on the Dimensions checkbox in the
HS5EView - Grid Select pop-up and press the OK button. This will cause the EOSView - Grid
Dimensions window (shown in Figure 5-7) to appear.

Figure 5-7. Grid Dimensions Pop-up

This window lists Dimension Names and Sizes for the selected Grid in table form in a scrollable
window. The items listed are non-selectable and are for display/verification purposes only. See
section 5.2.38 for a description of saving the contents of the window to an ASCII file.

This window is identical for displaying both Grid and Swath Dimensions.

5.2.9 Swath/Grid Data Fields

To view the Data Fields of the selected Grid object simply click on the Data Fields checkbox in
the HE5View - Grid Select pop-up and press the OK button. This will cause the HE5SView - Grid
Data Fields window (shown in Figure 5-8) to appear. See section 5.2.38 for a description of
saving the contents of the window to an ASCII file.
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Figure 5-8. Grid Data Fields Pop-up

To view a slice of the Grid Geolocation/Data Field data, move the pointer over the object and
double click the left mouse button. This will cause the HESView - Start/Stride/Edge pop-up
(shown in Figure 5-9) to appear. To view the group level attributes the user may select
Attributes — Data Fields... from the Data Fields Pop-up. A description of the attribute display
is provided in Section 5.2.36 Attributes Pulldown.
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Figure 5-9. Start/Stride/Edge Pop-up

Table 5-3 describes the Start/Stride/Edge pop-up fields.

Table 5-3. Start/Stride/Edge Pop-up Field Description

Field Name Data Type Size Entry Description
Start Integer N/A required |Start for grid geolocation/data field
data
Stride Integer N/A required |Stride for grid geolocation/data field
data
Edge Integer N/A required |Edge for grid geolocation/data field
data
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This pop-up displays the Start, Stride, and Edge values for each dimension (there may be up to

eight). The start value for each dimension may be edited but the stride and edge values may
only be edited for the selected dimensions. This is a way of subsampling the data desired. A
dimension may be selected by clicking on the check box next to the dimension name. A
maximum of two dimensions may be selected. Once the operator has entered the desired data
the OK button may be pressed and the selected dimension data will be displayed in the
HES5View - Grid Table. For more information on a Table, building a pseudo-color image, and the
Min/Max Values Pop-up, see Section 5.2.10. The operator may cancel all actions by pressing the
Cancel button.

Note that if an input error occurs, a warning dialog (Figure 5-10) will appear, displaying the
dimension name that is in error and a size total. The operator must meet the criteria in the
formula displayed in the warning dialog. Click OK to return to the Start/Stride/Edge Window to
re-enter the correct values.

Figure 5-10. Warning Dialog

5.2.10 Table

Selecting OK from the Start/Stride/Edge window brings up a table window as shown in Figure
5-11. The table window will display a 1 or 2 dimensional list of the data. The window is sizable
and contains horizontal and vertical scrollbars.

The File pulldown menu contains the following items, as shown in figure 5-11:

e Make Image - This will create a pseudo-color image of the selected table. Selecting this
option causes the Min/Max Values Pop-up to appear (figure 5-13).
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e Plot - if the table has been created from a Swath/Grid geolocation/data field the operator
has the option of converting the table to a surface or contour plot as shown in figure 5-
18.

e Statistics — HE5View has basic statistical capabilities for table data. An numerical table
will have the minimum, maximum and average for the entire table displayed in the
HES5View - Stats window (see figure 5-22). For a table created from Point level data the
same stats will be calculated for each column of data (field of Point level). The
HES5View stats window displays the name, min, max, and average values of a table. The
name corresponds to the name of the Swath, Grid, or Point field name. The data is not
editable and non-selectable. Hitting the “Ok” button will close the HE5View Stats
Window.

e Jump To — This option allows the operater to jump to a specific row in a table. Selecting
this option causes the Jump To Dialog to appear (figure 5-23). The user may enter the
desired row number. Once the OK button is pressed the desired row number will appear
in the first row of the table. See section 5.219 for a description of the Jump To... option.

e Save - This option allows the operator to save the table in either ASCII or binary format.
Once the operator has selected ASCII or binary from the cascading menu the HESView
File Save Dialog is displayed (see figure 5-24). This window is similar to the HESView
File Open Dialog. HE5View will only save tables to a new file, therefore, a unique file
name must be entered in the “Save as:” text field.

e Close Window - Closes the table window.
The Attributes pulldown menu contains the following items, as shown in figure 5-11:

e Field... - This will cause the local attributes to be displayed for this field. Selecting this
option causes the Attributes Text Display to appear (figure 5-11). A description of the
attributes display is provided in Section 5.2.11.
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Figure 5-11. HE5View Table Pop-up

5.2.11 Swath/Grid/Point Attributes

Clicking on the Grid Attributes checkbox in the HESView Grid Select Pop-up brings up the
Attributes Text Display shown in Figure 5-12.

0. _Fillvalue has value -7.000000
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Figure 5-12. Attributes Text Display Pop-up

This display shows the attributes associated with a particular dataset. The text display can be
closed from the File pulldown menu, the text can be modified using the Font and Style pulldown
menus, and additional help can be obtained from the Help pulldown menu (see Section 5.2.37
“Help Pulldown Menu.”)

5.2.12 Make Image From Table Data

A pseudo-color image can be built from the data displayed in the Table. The image can be
created by selecting File - Make Image from the menu bar of the HE5View - Table Pop-up.
Selecting this option causes the Min/Max Values window to appear as shown in Figure 5-13.
Table 5-4 describes the fields of the Min/Max Values Pop-up.

Figure 5-13. Min/Max Values Pop-up
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Table 5-4. Min/Max Values Window Field Description

(depending upon
original data
values)

Field Name Data Type Size Entry Description
Minimum Value integer or float N/A required [Min value used for the image
(depending upon (field size is limited by the values
original data that first appear when the window
values) opens)
Maximum Value Integer or float N/A required [Max value used for the image

(field size is limited by the values
that first appear when the window
opens)

From the Min/Max Values Window, the operator has the opportunity to enter the minimum and
maximum values used for the image. Pressing the Continue button will cause the HESView -
Image Display Pop-up to appear (shown in Figure 5-14). The operator may cancel all actions by

pressing the Cancel button.

Foom Factor: 3

Figure 5-14. Image Display Pop-up
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5.2.13 Image Display

The Image Display pop-up has the following pulldown menu options: File, Palette, Zooming,
Cursor, Window, and Help.

e Inside the File menu option, the Overlay option is active only if the image has been
created from a grid table. The Overlay option allows the operator to have lat/lon lines
drawn over the image or the operator may have an icon displayed at a point on the grid
image. See section 5.2.14 which describes the HESView lat/lon window for symbols and
cursor positioning. Selecting the Close option exits the Image Display Window.

e The Palette pulldown menu allows the operator to select colors from the following types
of palettes for comparison: Default, Greyscale, Antarctica, Rainbow, and World Colors.
The first palette option is "Default" which is the current default palette used by X-
Windows. The second palette option is "Greyscale" which will be a black and white
version of the image being displayed. The next three options are "Antarctica", "Rainbow"
and "World Colors." These three palettes are provided as part of HSEView. Selecting one
of these three palettes will cause the current image to use that palette

® The Zooming pulldown menu allows the operator to select from two zoom methods:
Bilinear Interpolation and Nearest Neighbor. Bilinear Interpolation uses interpolation to
calculate the probable color during an expansion/compression event; it gives a much
smoother image during zooming. The second is Nearest Neighbor which uses sub-
sampling or super sampling to determine probable color, e.g., two red pixels are now four
red pixels during expansion.

e The Cursor pulldown menu allows the operator to set the cursor at a specified position.
The first is “X-Y Position” . The Operator will be prompted for an X-Y location and the
cursor will be positioned at that location. In HE5View, position 0,0 is the lower left
corner (see section 5.2.15, which describes the HE5View - x-y cursor window). If the
image has been created from a grid table, the operator may enter a lat/lon position and the
cursor will be positioned to that location. See section 5.2.14 which describes the
“HES5View - lat/lon window (used for symbols and cursor positioning). If the image has
been created from a swath table the operator may position the cursor at the selected scan
line. The cursor will be placed at the beginning of the scanline. See section 5.2.16 which
describes the HESView Scanline Cursor Window.

e The Window option lists in a pull-down menu all windows which are currently open. See
Section 5.2.35 “Window Pulldown Menu.”

e Help — see Section 5.2.37 “Help Pulldown Menu.”

The Image Display also has the following pushbuttons: Zoom In and Zoom Out. It also has a
panning feature as described below.

e Zoom In and Zoom Out pushbuttons -- pressing the Zoom In button will cause the
image to be zoomed in and re-drawn in the image window. Pressing the Zoom Out button
will cause the image to be zoomed out until it returns to original size. The zoom factor
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will be displayed in the bottom left corner of the HESView - Image Display Window on
the status bar.

e Pan Window -- If the operator has zoomed in on an image, the operator may pan around
the image by holding down the left mouse button while the cursor is in the postage stamp
size image and moving it around. The cursor will be outlined by a box which indicates
the portion of the image being displayed in the full size image window.

The Image Display Pop-up also has cursor tracking capabilities. Placing the cursor on the image
and holding the left mouse button will cause the cursor position (in x-y coordinates) to be
displayed on the right side of the status bar. If the image has been created from a grid table the
cursor position will be displayed in lat/lon coordinates on the right side of the status bar.

5.2.14 Lat/Lon Symbol Pop-up

The HE5View Lat/Lon Symbol/Cursor pop-up (figure 5-15) allows the operator to enter the
desired coordinate pair in one of two ways. Degrees-minutes-seconds (DMS radio button) allows
the operator to type in the degrees (Deg), minutes (Min), and seconds (Sec) for the latitude and
the longitude. The second method is by entering degrees (DEG radio button) in the degrees text
fields. In either case the operator may switch between North (N), South (S), and East(E), West
(W) by using the list buttons to the right of the text entry fields. For both entry methods, hitting
the “Ok” button will cause the cursor to be positioned or a symbol drawn at the desired location.
Hitting the “Cancel” button will cancel the operation.
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Figure 5-15. Lat/Lon Symbol Pop-up

Table 5-5 describes the parameters in the Lat/Lon Symbol Window.
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Table 5-5. Lat/Lon Symbol Window Field Description

Field Name Data Type Size Entry Description

Lat (DMS) float N/A required |Latitude (if DEG is selected)

Lon (DMS float N/A required |Longitude (if DEG is selected)

Lat/Lon (Deg) float N/A required |Degrees of Latitude/Longitude (if
DMS is selected)

Lat/Lon(Min) float N/A required |Minutes of Latitude/Longitude (if
DMS is selected)

Lat/Lon(Sec) float N/A required |Seconds of Latitude/Longitude (if
DMS is selected)

5.2.15 X-Y Cursor Window

The operator may enter the X-Y coordinates to have the cursor positioned by using the HESView
X-Y Cursor Pop-up (figure 5-16). The operator may enter the desired X-Y location in the
corresponding X-Y text field. The X-Y limits are placed to the right of the text fields. Hitting
the “Ok” button will cause the cursor to be placed at the desired location in the image. Hitting

the “Cancel” button will cancel the operation.

Figure 5-16. X-Y Cursor Pop-up

Table 5-6 describes the parameters in the X-Y Cursor Pop-up.
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Table 5-6. X-Y Cursor Window Field Description

Field Name Data Type Size Entry Description
X: integer N/A required |X horizontal coordinate (max
accepted value is listed to the right
of the text field)
Y: integer N/A required |Y vertical coordinate (max accepted

value is listed to the right of the text
field)

5.2.16 ScanLine Cursor Window

If the image was created from a Swath table the operator may position the cursor to the
beginning of the scanline by using the HE5View - ScanLine Cursor Pop-up (figure 5-17).
Moving the slider left and right will cause the scanline value below the slider to decrease and
increase, respectively. Once the desired scanline is achieved, hitting the “Ok” button will cause
the cursor to be placed at the beginning of the scanline. Hitting the “Cancel” button will cancel

the operation.

Figure 5-17. Scanline Cursor Pop-up
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— HESView — Contour Plot Window

File Plot Type Hodify Plot Data  Window

10 ! ! ! ! | ! ! ! ! ! ! ! ! ! ! ! !

Figure 5-18. HE5View Contour Plot Pop-up

5.2.17 Surface/Contour Plot

The HE5View Contour/Surface Display will display a surface or contour plot of the selected
numeric table. The window contains a menubar and can be resized. The plot may be displayed
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by selecting either File — Plot — Contour or File — Plot — Surface from the HE5View table
display window (see section 5.2.10).

The File menubar option contains only one option. Selecting Close will close the
surface/contour plot window.

The Plot Type menubar options acts as a toggle between the surface and contour plots. If
the current plot being displayed is a contour plot then the option listed will be Surface Plot.
If the current plot being displayed is a surface plot then the option listed will be Contour
Plot. Selecting this option will cause a new window to appear with the selected plot.

The Modify Plot Data menubar option allows the user to modify the plots based on three
criteria. The user may modify a plot by excluding a range of data, excluding up to three
individual values, or plotting between a minimum and maximum value.

The Window option lists in a pull-down menu all windows which are currently open See
Section 5.2.35 “Window Pulldown Menu.”
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Figure 5-19. Contour/Surface Data Range Pop-up

The option Data Range to Exclude listed under the Modify Plot Data menubar option will
cause the Contour/Surface Data Range window to appear (figure 5-19). The user can select a
range of data to exclude from the plot by entering the minimum value to exclude in the
Minimum Value text field and the maximum value to exclude in the Maximum Value text field.
The user can select the number of contour levels desired by entering the number in the Contour
Levels text field. Entering data in the Contour Levels text field is optional. The Contour Levels
text fields will only appear in the Data Range Pop-up if the plot was a contour plot. Pressing the
Continue button will cause a new plot to be drawn without the data range entered. Pressing the
Cancel button closes the window with no further action.

Figure 5-20. Contour/Surface Data Value Pop-up
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The option Data Value listed under the Modify Plot Data menubar option will cause the
Contour/Surface Data Value window to appear (figure 5-20). The user can enter up to three
values that will not be plotted. The first value should be entered in the Data Value 1 text field,
the second value should be entered in the Data Value 2 text field, and the third value should be
entered in the Data Value 3 text field. The user can select the number of contour levels desired
by entering the number in the Contour Levels text field. Entering data in the Contour Levels text
field is optional. The Contour Levels text fields will only appear in the Data Range Pop-up if the
plot was a contour plot. Pressing the Continue button will cause a new plot to be drawn without
the selected data values. Pressing the Cancel button closes the window with no further action.

Figure 5-21. Contour/Surface Min/Max Range Pop-up

The option Min - Max Range listed under the Modify Plot Data menubar option will cause the
Contour/Surface Min/Max Range window to appear (figure 5-21). The user can enter a range of
values that is desired to be plotted. All values less than the minimum value and greater than the
maximum value will not be plotted. The minimum value to be plotted may be entered in the
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Minimum Value text field. The maximum value to be plotted may be entered in the Maximum

Value text field. The user can select the number of contour levels desired by entering the
number in the Contour Levels text field. Entering data in the Contour Levels text field is
optional. The Contour Levels text fields will only appear in the Data Range Pop-up if the plot
was a contour plot. Pressing the Continue button will cause a new plot to be drawn using the
data range entered. Pressing the Cancel button closes the window with no further action.

; Name Min
| Vegetation 10.000000

Figure 5-22. HE5View Stats Pop-up

5.2.18 Statistics Pop-up

The HE5View Statistics Pop-up window (figure 5-22) will list the minimum value, maximum
value and average value in a table. For a table created from HDF-EOS field data the values will
be taken from the entire table. No statistics will be calculated for character data. To close this
window press the OK button.
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Figure 5-23. Jump To Dialog

5.2.19 Jump To Dialog

The user may jump to a specific row number in a table by seleecting the Jump To... option.
Selecting this option will cause the Jump To Dialog (Figure 5-23) to appear. This dialog will
accept integer input in the range listed in the text field preceded with “Enter row number...”
Pressing the “OK” button will cause the table to jump to the selected row number. Pressing the
“Cancel” button will close the Jump To Dialog with no action being taken on the table.
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Figure 5-24. File Save Dialog

5.2.20 File Save Dialog

The user may save a table in HE5View in one of two ways. The table may be saved in either an
ASCII format or it may be saved as a binary file. Selecting the save option will cause the File
Save Dialog to appear. The user may then enter the name of the file that is desired to save the
table into. HESView will only save the table to a new file.

Table 5-7 describes the File Save fields.

Table 5-7. HE5View File Save Field Description
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Field Name Data Type Size Entry Description

Filter system generated |unlimited ([required |displays file selection parameters to
(editable) filter the directories
Directories selection unlimited |required |displays a list of directories
Files selection unlimited |required |displays a list of files
Save As system generated [unlimited [required [displays the filename selection -
(editable) user may enter to new filename in
this field

In addition, the following pushbuttons are provided:
e OK - saves to the specified file
e Filter — filters through the directories in layers until the desired directory is displayed

® Cancel — closes the file save dialog

5.2.21 HE5View Swath Select

In this example, the SwathFile.hdf file was selected from the File Selection dialog, bringing up
the File Contents Pop-up shown in Figure 5-25.

E Double—click on an object to dizplay é

Figure 5-25. SwathFile File Select Pop-up

Double clicking on an item in the File Select window brings up the Swath Select Pop-up shown
in Figure 5-26.

30



Figure 5-26. Swath Selection Pop-up

As many options as desired can be selected from the following list: Dimensions, Geolocation
Mappings, Indexed Mappings, Geolocation Fields, Data Fields, Profile Fields, and Attributes.
Selecting OK will bring up windows for all the items selected. Clicking on Cancel will close the
Swath Selection Pop-up with no action being taken. Assuming that all the items have been
selected, the following windows will appear.

5.2.22 Swath Dimensions

To view the dimensions of the selected Swath object, click on the Dimensions checkbox in the
H5EView - Swath Select pop-up and press the OK button. This will cause the HE5View - Swath
Dimensions pop-up to appear. This window lists the Dimension Names and Sizes for the selected
Swath in a table form in a scrollable window. The items listed are non-selectable and are for
display/verification purposes only. This window is similar to the Grid file dimensions window
described in Section 5.2.9 “Swath/Grid Dimensions.”
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5.2.23 Swath Geolocation Mappings

To view the Geolocation Mappings of the selected Swath object, click on the Geolocation
Mappings checkbox in the HE5View - Swath Select pop-up and press the OK button. This will
cause the HESView - Swath Geolocation Mappings window (shown in Figure 5-27) to appear.

Figure 5-27. Swath Geolocation Mappings Pop-up

This window lists the Geolocation Dimensions, Data Dimensions, Offsets, and Increments for
the selected Swath in a table form in a scrollable window. The items listed are non-selectable
and are for display/verification purposes only. See section 5.2.38 for a description of saving the
contents of the window to an ASCII file.

5.2.24 Swath Indexed Mappings

To view the Indexed Mappings of the selected Swath object, click on the Indexed Mappings
checkbox in the HESView - Swath Select pop-up and press the OK button. This will cause the
HES5View - Swath Indexed Mappings pop-up (shown in Figure 5-28) to appear.
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Figure 5-28. Swath Indexed Mappings Pop-up

Viewing the size of the mapping may be performed by moving the pointer over the object and
double clicking the left mouse button. This will cause the HE5View - Indexed Mapping Sizes
pop-up (shown in Figure 5-29) to appear. See section 5.2.38 for a description of saving the
contents of the window to an ASCII file.
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Figure 5-29. Index Mapping Sizes Pop-up

This window lists the Geolocation Indices and Data Indices for the selected Swath in a table
form in a scrollable window. The items listed are non-selectable and are for display/verification
purposes only. The window can be closed by selecting “Close” from the File menu. See section
5.2.38 for a description of saving the contents of the window to an ASCII file.

5.2.25 Swath Geolocation Fields

To view the Geolocation Fields of the selected Swath object, click on the Geolocation Fields
checkbox in the HESView - Swath Select pop-up and press the OK button. This will cause the
HES5View - Swath Geolocation Fields window (shown in Figure 5-30) to appear.
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Figure 5-30. HE5View Geolocation Fields Pop-up

Selecting a Swath Geolocation to view a slice of the data may be performed by moving the
pointer over the object and double clicking the left mouse button. This will cause the HE5View -
Start/Stride/Edge pop-up to appear. This window lists the Start, Stride, and Edge values for each
dimension listed. This window is similar to the Grid file Start/Stride/Edge window described in
Section 5.2.12 “Make Image From Table Data.” See section 5.2.38 for a description of saving
the contents of the window to an ASCII file.

5.2.26 Swath Data Fields

To view the Data Fields of the selected Swath object, click on the Data Fields checkbox in the
HES5View - Swath Select pop-up and press the OK button. This will cause the HE5View - Swath
Data Fields pop-up to appear. This window is similar to the Grid file data fields window
described in Section 5.2.19 “Swath/Grid Data Fields.” See section 5.2.38 for a description of
saving the contents of the window to an ASCII file.

5.2.27 Swath Attributes

To view the attributes of the selected Swath object, click on the Attributes checkbox in the
HES5View - Swath Select window and press the OK button. This window is similar to the Grid
file attributes pop-up described in Section 5.2.11 “Swath/Grid/Point Attributes.”

5.2.28 Profile Fields

The profile fields interface is not complete with this version of HESView.

5.2.29 Point Files

In this example, selecting PointFile.h5 from the File Select dialog brings up the File Contents
pop-up shown in Figure 5-31.
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Figure 5-31. PointFile File Contents Pop-up

Double-clicking on an item in the PointFile pop-up (in this example, the Group: FixedBuoy
Point {POINT} object is selected) opens the Point Select Pop-up shown in Figure 5-32.

Figure 5-32. Point Select Pop-up

Either Point Data, Attributes or both options can be selected. Clicking on OK will open the
corresponding windows for the options selected. Clicking on Cancel will close the Point Select

36



Pop-up with no action being taken. Assuming both items have been selected, the windows as
described below will appear.

5.2.30 Point Data

To view the Point Data of the selected Point object, simply click on the Point Data checkbox in
the HESView - Point Select window and press the OK button. This will cause the HESView-
Point Level Info pop-up to appear as shown in Figure 5-33.

Figure 5-33. Point File Level Information Pop-up

Double-clicking on any Level Name will bring up the Point field select pop-up, shown in figure
5-34. See section 5.2.38 for a description of saving the contents of the window to an ASCII file.
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Figure 5-34. HE5View - Point Field Select Pop-up

Table button - Once the operator has selected the fields desired, pressing the table button
will cause the Point data to appear in a table.

Attributes button - The operator may select and display the group level attribtues for the
selected Point. A description of the attribute display is provided in section 5.2.36. (see
figure 5-38).

Cancel button - Cancels all actions
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The operator may select as many fields as desired. Fields with multiple dimensions will appear
in a table by themselves. All fields selected that contain one dimension will appear in the same
table. The table title will list the names of the fields displayed in the order of display. Upon
selecting the desired fields and pressing the Table button will cause the Point Data Table Pop-
Up to appear (Figure 5-35).

Figure 5-35. Point Data Table Pop-Up

5.2.31 Point Data Table

To close this window select Close from the file pulldown menu.

5.2.32 Point Attributes

To view the attributes of the selected Point Select object, click on the Attributes checkbox in the
HES5w - Point Select window and press the OK button. This window is similar to the Grid file
attributes pop-up described in Section 5.2.11 “Swath/Grid/Point Attributes.”
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5.2.33 Pulldown Menus

The File Contents Displays all have a common pulldown menu structure with the following
options: File, Options, Window, Attributes, and Help. These are described in the sections below.

5.2.34 File Pulldown Menu

The File pulldown menu consists of the following options: File Info, Save, and Close. The Close
pulldown menu will close the File Contents Display Pop-up and all windows derived from the
window. The Save feature is described in section 5.2.38 “Save Pulldown Menu.” The File Info
pulldown menu selection allows the operator to bring up information on the number of Swath
objects and Grid objects in the file and is shown in an information dialog in Figure 5-36.

Figure 5-36. File Information Dialog

Clicking the OK button closes the File Information Dialog.

5.2.35 Window Pulldown Menu

The Window pulldown menu lists all windows which are currently open. Any window selected
from this list will be shuffled to the top. Figure 5-37 shows the Window pulldown menu
provided when the HESView Main Window, Point.h5 and Swath.hS5 files are open.
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Figure 5-37. HE5View Main Screen Showing Window Pulldown Menu

The Window pulldown menu provides the same function on all other screens on which
it appears.

5.2.36 Attributes Pulldown Menu

The Attributes option contains one pull-down menu item “HDF-EOS....” which brings up a text
file window (shown in Figure 5-38) with a list of attributes (e.g., parameters, values, version
numbers) for the entire file or brings up a dialog which states that there are no attributes
available.
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4 0.7 Begin value for Structhetadata 0 ===
A GROUP=5wathStructure
| GROUP=SWaTH_1
| SwathMame="Syath1"
GROUP=Dimension
CBJECT=Dimension_1
DitmensionMame="GeaTrack"
Size=210
EMD_OBJECT=Dimension_1
CBJECT=Dimension_g
DitmensionMame="Geoxtrack"
Size=110
EMD_OBJECT=Dimension_¢g
CBJECT=Dimension_3
Ditnensiontame="Restt"
Size=410]
EMD_OBJECT=Dimension_3
CEBJECT=Dimension_d4

Figure 5-38. Text Display Pop-up

From the text window, the operator can do the following using the pull-down menus:
e File — exit the window

e Font — select from a list of fonts (e.g., courier, Helvetica). A box showing what the text
looks like based on the selection is provided.

e Style — select from a list of styles (e.g., normal, bold, italic) and point sizes (e.g., 8 pt,
10 pt.)

e Help —see Section 5.2.37 “Help Pulldown Menu.”
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5.2.37 Help Pulldown Menu

The Help option contains a pulldown menu with the following selections: help on context, on
help, on window, keys, contents, index and version.

Help On Context — turns the mouse pointer into a “?” which can be clicked on an area of
interest, bringing up help text for that item.

Help On Help — tells the operator how to use the HE5SView on-line help feature (see Figure 5-
39) to help understand how to navigate through the Help system using the on-line
hypertext system.

HESView %

HESWiew help is an on-line hypertext system designed
{10 aid in the use of HESView This page is pravided for the
 user to understand how to navigate through the Help system.

The vertical scroll bar is provided to allow the user to
| scrall the page currently displayed in this window. The

| Search hutton will display a windaw which will allow the

| user to search the HESYiew Help system by keywwords or

| topic. The Go To.. button will allow the user to move directly
| to a paricular index, a glossary, a contents section, a

| keyhoard section, orto a marked page. The hdark, button will
| allowy the user to mark a page for later reference. If the user

Figure 5-39. HE5View On Help Pop-up

e File — allows the operator to exit the On Help window. Print and Print Setup are not
available.

e Edit — allows the operator to Copy, Copy Part of a Topic, or Copy as Wrapped
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e Navigate — allows the operator to search for a topic, go to a specified topic, bookmark
items of interest, go forward and back to a topic (these items are available in the form of
pushbuttons at the bottom of the screen), and view a previous or next topic.

e Help — provides help on how to use help and “about help” (not functional).
The On Help window provides the following pushbuttons:

® The "Search..." button provides a way to search the HESView Help system in one of
two ways. The operator may select to search by Topic in which case a list of topics will
be displayed for the operator to choose from or the operator may select search by
Keyword in which case the operator will be presented with a list of keywords from which
to choose.

® The "Go To..." button allows the operator to move to one of five topics:
1. Index - the help described in the Help - Index selection from the menu bar.
2. Glossary - a defined glossary of selectable terms common to HESView.
3. the help described in the Help - Contents selection from the menu bar.
4. the help described in the Help - On Keys selection from the menu bar.
5. any marked page (see below).

e The "Mark" button allows the operator to mark a page. Once the page is marked the
page appears in a list box in the "Topic Go to Dialog" box. The marked page may then be
selected and immediately recalled. The "Mark" button will appear as "Unmark" when
viewing a marked page.

e The "Unmark" button allows the operator to unmark a marked page. If the operator is
currently viewing a marked page an "X" appears in the check box labeled "Marked:."
Pressing the "Unmark" button will cause the "X" to disappear and the page will not
appear in the list box of the "Topic Goto Dialog."

e The "Back" button will return the operator to the previously viewed page. The operator
should think of the help system as a book. The back button will only appear sensitized if
the previously viewed page would be logically backward from the point of current view.

e The "Forward" button will move the operator to the last forward page viewed. The
operator should think of the help system as a book. The forward button will only appear
sensitized if the previously viewed page would have a page number greater than the page
being currently viewed.

Help On Window
The Help On Window is the same as the Help On Index Window shown below.
Help On Keys
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When Help On Keys is selected from the Help pulldown menu, the following message will
appear in a Keys Window: “HE5View uses no special keys to traverse through the program. To
navigate through HESView simply use the mouse and click on the options that are desired.”

Help On Contents

The Help On Contents window tells the operator that HESView is a tool written to assist
operators view the contents of HDF files and that it is capable of displaying the contents of files
containing HDF-EOS data. More help can be obtained by selecting the topic desired (see figure
5-40).

HESYWiew is a tool written to assist users view the
| contents of HOFS files. It will display the contents of

| HDF-EOS Version 5 objects (Swath/Grid/Poinf) in HDFS
| formatted files.

For more help select the topic desired.

Indes

Help Cn Help
Help On Keys

Figure 5-40. Help On Contents Pop-up

Help On Index

Selecting Help On Index brings up the Index window shown in Figure 5-41. This pop-up
presents a list of each HESView window and a list of hypertext help items.
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Click on atopic helow to see information about that topic.

| Last update: 25-Jan-01

HESWiew README

HIEYiew kain Window

Cpening an HOFS File
Selecting a Window
E=iting HESWieny

Help Cn Help

Figure 5-41. Help On Index Pop-up

Help On Version

Selecting Help On Version from the Help pulldown menu brings up the dialog shown in
Figure 5-42.

Figure 5-42. Help On Version Dialog
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Clicking on the Help button takes the operator to the Help on Contents screen (figure 5-40).
Click on Cancel to close the dialog.

5.2.38 Save Pulldown Menu

The Save option allows the user to save the contents listed in the window to an ASCII file.
Selecting the Save option will display the File Save Dialog (Figure 5-24). Upon entering a
unique file name the contents of the window will be saved to an ASCII file exactly as they are
listed in the window. This Save option is different from the HE5View table save option
(described in section 5.2.20) in that there is no option to save in binary format. This option
exists in HESView windows which incorporates a scrollable text list as the main window
function.
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